
 

 

Retrieve Programming 
in Q&A and Sesame 
BY ALEC MULVEY 
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Answer
 

The Do-It-Yourself Guide to Q&A 

Q&A’s database search options are extensive. When these run 
out you can always use a programmed Retrieve Spec. This 
more recent capability—programmable Retrieves, added in 

Q&A version 4.0—is not used nearly as much as it ought to be. The 
good news is that Sesame supports Retrieve Spec programming just 
like Q&A. There are some relatively minor differences between the 
two, however. I want to tell you what these are, and in the process 
show you how you can use Retrieve Spec programming to good effect. 

Retrieve Programming: two methods 
Retrieve programming must be enclosed by what are called “French 
braces” { }. They contain the programming expression you want Q&A 
to evaluate, which will determine which record or records Q&A 
returns to your desktop, or to a mail merge, Mass Update, Report or 
other task that includes record selection as part of it. Your expression 
can take one of two forms: Either a value, such as a number, a date or 
a text string, or a Boolean expression that evaluates to either True or 
False. 

As an example of a value expression, let’s take a search for dates 
falling due within the next seven days, where the due date will 
always be in the future. At the Retrieve Spec, you could type the 
following into the Due Date or similarly named field, as long as it’s a 
proper date type field: 

< { @Date + 7 }
 

Notice that the less-than operator (<) is outside the main 
expression enclosed by the French braces. In this case, the expression 
is evaluated by Q&A and returns a date seven days in the future from 
the current date. When coupled with the “<”, this tells Q&A to find 
all the records where the Due Date field contains a date that is earlier 
than the date that is seven days from today. 

Another example would be to find people with four-character 
surnames: 

Surname: ={@Len(Surname) = 4}
 

This would produce records containing surnames such as Bird 
and Shaw. 

This is the first way to use Retrieve programming. You could call 
it “implied comparison,” since the expression directly relates to the 
contents of the Retrieve Spec field in which you’ve typed it. 

The second method—call it “truth-of-expression”—is 
independent of the field into which it is typed. It can be considered 
“universal” to all the fields on the form. It starts with the French 
braces: 

Surname: {@Len(Surname) = 4}
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When the expression inside the 
French braces is evaluated and then 
tested against a particular record, it 
will result in either a “True” or a 
“False.” If true, the record is included; 
if false it is not. A programming 
expression used in this way does not 
relate to the field it happens to be put 
in. Place it in a different field and the 
result will be the same. 

About Sesame 
Q&A and Sesame support both these 
methods. But there is a difference you 
need to know. 

Continues  on page 3 



 

 
 

  
 

 
 

 
 

 

 
 

 

 
 

 

 

ANNOUNCEMENT 

Sesame Release Date Announced! 
Lantica Software, LLC proudly announces that it will release its 
new Sesame database management system for public sale on 
October 15, 2003 

Exciting product features include: 

• Remote Internet access to your Sesame databases 

• True client/server network operation 

• Windows/Linux 32-bit compatibility and interoperability 

• HTML reports 

• Built-in email capabilities 

• Support for graphic images in database 

• Open Database Connectivity (ODBC) compliant 

• Relational capabilities 

• Multiple forms per database. Forms within forms. 

• Compatibility with Symantec Q&A® databases.Translates Q&A for DOS 4.0 

and 5.0 databases, as well as Q&A for Windows databases 

• Supports all Windows printers 

• Fully programmable using Q&A-like language with a host of
 

powerful new features
 

• Much, much more 

Sesame will be priced as follows: 

l icensesingle-userwithpack agecl ient/ser verFul l 
manualsuserand printed 

$249 

users)*addit ional(1-4cl ient l icensesMultiuser $149 

users)*addit ional(5-9cl ient l icensesMultiuser $129 

users)*addit ional(10-24cl ient l icensesMultiuser $109 

users)addit ional(25+cl ient l icensesMultiuser CALL 
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 Program Retrieves cont’d from page 1 

We all know that Q&A is a very forgiving product. 
You can put “Don’t Know” in a date field. You can 
name a field “150” and have a programming statement 
that says: 

Total = #200 + 150
 

Q&A will use the value that’s in field 150 rather 
than add the number 150. That’s neat. But it’s extremely 
difficult to replicate in a modern program that has a 
wider scope than Q&A. 

Q&A’s forgiving nature extends to Retrieve Spec 
programming as well. You’ve seen these two methods. If 
you use the first method, your programming expression 
produces a value. If you want that value to be compared 
to a field, you can put it in that field and put an equal 
sign in front of the French braces. In Q&A, if you omit 
the equal sign, Q&A will handle it anyway. Likewise if 
you do the opposite, and put an equal sign in front of 
the French braces when using method two, Q&A 
accommodates these errors. Sesame doesn’t. 

The following are valid in Sesame: 

Rating: ={Key - 14}
 

Any Field: {Rating = Key - 14}
 

However, if you swap the equal sign to the second 
example, it is incorrect syntax and won’t work in 
Sesame, even though this improper practice is tolerated 
in Q&A. 

One thing you won’t be able to carry forward to 
Sesame is the use of logical field numbers in 
programming. You have to use field names, plain and 
simple. Logical field numbers are actually a carryover 
from Q&A 3.0, where you couldn’t use field names in 
programming and were forced to assign a logical field 
number to any field you wanted to reference in 
programming.. 

Again, this can be justified by stating that Q&A is 
extravagantly accommodating regarding such 
numbering. The numbers used are just for the Program 
Spec. So, you can have a numbering scheme in the 
Program Spec, another in the Navigation Spec, another 
in each of many saved Mass Update Specs, more yet in 
saved Retrieve Specs, and so on. 

Using field names is ultimately just simpler. 
I have to admit, though, that I will miss the ability to 

do this: 

Any Field: {#1 <@Date + 7}
 

Date1:#1
 
Date2:
 
Date3:
 

Why? Because as I can run the search, press F7 to 
return to the Retrieve Spec, and simply move the “#1” 
from one field to the next. I find this particularly useful 
for those very complicated programmed Retrieves I 
sometimes need. I can save the retrieve with #1 in one 
field, then load that retrieve and put the #1 into a 
different field. 

Why would you want Retrieve Spec programming? 
Being able to use Retrieval expressions can come in 
handy in various situations. They come into their own 
when you use them as Saved Retrieves. This can be as 
standalone Retrieve Specs, or as the Retrieve Spec saved 
as part of Reports or Print Specs. 

Compare to current date 
As you saw in the first example, you can compare a date 
field to the current date. This is invaluable for finding 
records for the next week, for the last 14 days, for next 
month, for this month, for the past 90 days, and so forth. 
You don’t have to type in a new range of dates every 
time you perform the task, such as: 

Date Due: >=8/14/2003..<= 8/21/2003
 

or simply this: 

Date Due: 8/14/2003..8/21/2003
 

Here are a few more examples of using Retrieve Spec 
expressions with date ranges: 

{JobDate >= @Date - 7 And JobDate <=@Date + 7}
 

(JobDate 1 week either side of today.) 

{@Month(JobDate) = @Month(@Date) And
 
@Yr(JobDate) = @Yr(@Date)}
 

(JobDate this month.) 

{@Replace(DOB, @Yr(DOB), @Yr(@Date)) >=
 
@Date and
 
@Replace(DOB, @Yr(DOB), @Yr(@Date)) < @Date +
 
7}
 

(Birthday (DOB) within the next week.) 

Searching for non-standard characters 
Retrieve Spec programming can help you find 
characters that shouldn’t be in a field. For example, to 
search for “±” in a field named Reading1: 

{@Instr(Reading1, @Chr(241)) > 0}
 

Concludes on page 15 
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Sesame 
Seeds	 Using Sesame Tutorials 

Part 2—Design an Application 
ERIKA YOXALL 

Several months ago, Erika Yoxall, a member of the Sesame 
development team, prepared a “Quick Start” tutorial guide 
designed to introduce beta testers to the first general 
Sesame beta release. (Until then, beta testing had been 
limited to a small select group of individuals close to Lantica 
Software.) Erika’s tutorials, which include Create an 
Application, Design an Application, Translate a Q&A Database, 
and Fixing Common Q&A Translation Issues, are being 
featured  here in The Quick Answer. Part1—Create an 
Application appeared in the March 2003 issue. This month, 
we continue in the series with Part2—Design an Application. 
We think you’ll find these tutorials of interest if you’re 
planning a migration to Sesame. 

Note:—Due to the number of screen shots and 
relatively small amount of text (the pictures tell the 
story), we have departed from our usual format and 
kept all the screen shots in line with the tutorial text. 
Keep in mind that the screen shots have been scaled 
to fit within the confines of our two-column format. 

IN this tutorial, we will build a simple Sesame 
Application using Sesame Designer. For this 
example, we will create a basic Contacts application. 

Step 1 – Starting Sesame Designer 
Start Sesame by clicking on the Sesame icon on your 
Desktop. 

On the File menu, click New Application. 

Sesame Designer will open in a new window. (See 
top of adjacent column.) 

Step 2 – Creating A New Application 
On the File menu in the Sesame Designer window, click 
New Application. 

You are asked to select a filename for your new 
application. Type c:\sesame\data\contacts.dsr in the 
Filename box. (See below.) Click Accept. Your new 
application will be saved under this filename. Sesame 
Designer will also create a second file called 
contacts.ddt. Together, these files hold your entire 

application design. 

Sesame Designer 
creates the structure 
of a new 
application. By 
default, the 
application is 
named 
NewSesameApplication. 
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Step 3 – Creating A New Database 
Creating a new database is as simple as adding a form. 
On the Design Menu Tree, click Forms to expand the 
Forms menu. Click Design A Form to expand the menu. 

Click Add New Database. 
Sesame Designer opens a new Design Tab with a 

blank Form. 

The new Form is named NewForm by default. Let’s 
change that. The left side of the Design Tab shows the 
various Control Panels. To change the Form name, we 
want the one called Property Editor. It should be the third 
one from the top. Many changes are made using the 
Property Editor. Find the Property Editor and click on 
the Other tab. At the top of this Tab is a dropdown 

called 
Options For. 
Select Form. 

The 
options for a 
Form are 
displayed. 
In the Name 
box, type 
Contacts. 
Click the 
button next 
to the Name 
box. Notice 
that the text 

on the Design Tab label at the bottom of the screen (in 
yellow) has changed from “Design Form NewForm” to 

“Design 
Form 
Contacts.” 

To see the 
results of 
your 
changes, 
find the 
Control 
Panel called 
Property 
Viewer. It is 
located right 
below the 

Property Editor. 
You may need 
to resize your 
window or 
drag the 
scrollbar thumb 
down to see it. 

From the 
View Settings 
For dropdown, 
choose Form. 
The Property 
Viewer now 
displays the 
current settings 
for the Form. 
Click on the 
Other tab. The 
first item 
should show 
the Form Name 
as “Contacts.” 

Continues on 
page 10 
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@@@@@Help EDITED BY WILLIAM HALPERN 

Unexpected Problems with New HP Laser Printer 
I have followed all the discussions about printers and 
what we should use with Q&A for DOS to make sure we 
are able to successfully print. I went out and bought a 
new HP 2300L laser printer figuring that it would meet 
both the needs of my Q&A for DOS applications and 
surely print from my Q&A Win apps. To my surprise and 
chagrin, it prints somewhat okay from Q&A for DOS, but 
prints garbage from Q&A Win. Any suggestions? 

Sara 

I’m pretty sure that this is a printer driver issue. Most 
newer HP laser printers have an option during install to 
set up the printer using the PCL5 or PCL6 language 
driver, or both. The default is usually PCL6, which is 
their enhanced PCL XL driver for better GUI support 
and backwards compatibility. For most Q&A users, this 
isn’t the best choice. Q&A does not handle this driver 
very well even though the printer drivers are 
supposedly installed. More interestingly, Q&A for 
Windows has trouble with the fonts. 

Uninstall your printer from Windows and then do a 
custom reinstall, selecting PCL5 as the desired option. In 
Q&A for DOS, install the printer as an HP LaserJet III or 
4. Nothing need be done in Q&A for Windows. 

P.S. Sara wrote back to say that this solved her printing 
problems. 

Q&A Win Won’t Print Converted DOS Reports 
I needed to migrate to Q&A for Windows from Q&A for 
DOS because my company adopted a no-DOS-programs 
policy and purchased all new inkjet printers that Q&A for 
DOS can’t even recognize. Now I have a major problem. 
My old reports from Q&A for DOS look awful. They were 
formatted for the wrong printer, things don’t line up 
properly, and I can find no way to fix them. Do I have to 
redesign them all from scratch? Help! 

Carolyn 

A quick tip and a little trick. Q&A for Windows 
recognizes your DOS columnar reports and can print 
them if everything is just right. You will lose some 
features, like your fonting, margins, and header/footer 
programming but that may be acceptable. However, if 
the reports need updating or changing, what do you do? 
Easy, select Design Reports and Labels in Q&A for 
Windows, open the DOS columnar report that needs 
changing and then, from the Reports menu, select Save 
as Freeform. You can even use the same report name. 
Then, open the design of that new freeform report, and 
you’ll have all of the facilities of Q&A for Windows to 
modify that old DOS columnar report. 

Needs Gosub in a Mass Update 
I need to run an extremely complex gosub routine 
(already in my Program Spec) for a one-time mass 
update. The problem is that mass update only gives me 
the option to run On-record-entry statements, Calculation 
statements, or On-record-exit statements. My gosub is not 
an on-record-entry or on-record-exit program, and it 
can’t be made into a calculation statement because Q&A 
says it’s an invalid programming statement if it is not 
proceeded with a “<” or a “>” sign. I would even be willing 
to duplicate the programming statement in a Mass 
Update Spec (although that would be very time 
consuming) if I had to. Can you guys offer any 
suggestions? 

Margo 

Here it is. A simple suggestion and a way to get around 
Q&A’s stubbornness. Mass update will not allow you to 
execute any goto’s, or on-field-entry or on-field-exit 
programming. However, as you have noted, it will allow 
you to execute on-record-entry or on-record-exit 
programming during the mass update. Look carefully at 
your programming, make sure that you are not going to 
do anything you regret, and set your gosub field to 
temporarily be the on-record-entry or on-record-exit 

Send your Q&A questions to @Help, The Quick Answer, Marble 
Publications, Inc., 1927A Harbor Blvd, Costa Mesa, CA 92627 or email to 
mailbox@quickanswer.com.  Include your name, address, phone, and your 

Q&A version number (and whether DOS or Windows) and a detailed description of the problem. We’ll publish 
those questions we feel are of general reader interest; individual responses aren’t possible. 

Stumped? 
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statement. Run your mass update. Check that it all 
worked. Go back and reset the on-record-entry/exit as it 
was prior to the mass update. The secret is that Q&A can 
perform a gosub when you enter or leave a record. (You 
wouldn’t want to do this on a regular basis since it can 
slow down browsing depending on the complexity of 
the gosub.) And an on-record-entry or exit statement can 
also be an on-field-entry or exit statement. Oh, did I 
mention that you should only do this on a backup of your 
database? 

Q&A Won’t Accept Default Paths 
We run Q&A 5.0 for DOS on our new computers over a 
network, but are finding things a bit of a struggle. The 
default path is to C:\\QADOS50\. But to get stuff, we have 
to enter \\aia3\printsvr\qa5. I designed a little macro that 
enters that string at the Main menu, which helps a lot for 
searching in the databases. But whenever I go to print or 
try to Get documents in Write, I have to figure out what 
path the machine wants in order to get to where I need 
to go. It’s a bit of a drag. I have tried your suggestion to 
use Utilities / Set Global Options to set default paths, but 
it won’t accept the string \\aia3\printsvr\qa5. Q&A gives 
me a message that says: “You have selected a directory 
that does not exist. You can either create this new 
directory or cancel the operation: 
C:\\aia3\printsvr\qa5. Do you want to create the 
directory?” When I say, yes, Q&A just closes the screen 
and nothing changes. 

I could create more macros, where each one would 
take us to a different job, however, the Global Options 
would be much better if I could get it to work. Any 
suggestions? 

Connie 

The problem here is that Q&A will not accept UNC or 
URL naming (“\\Server\C\...”) at the Set Global 
options screen. It needs to see a Drive letter (A: through 
Z:). What you have to do is this: 

1. Share the folder \\aia3\printsrvr on the server 
computer. 

2. Set up a mapped drive on each workstation which 
maps Q: as \\aia3\printsrvr\. 

3. In Q&A, set your Global Options defaults to Q:\qa5. 
Note that you do not map all the way down to the 
Q&A folder and then try to set the Q&A default 
database directory to Q:\. That’s because there’s a bug 
in Q&A 5.0 that will not allow setting the default 
folder to a root drive letter. 

Locked Out of Database 
This might sound crazy, but here goes. I have been using 
Q&A for years and years. I love it, and depend on it so 

much that I’ve even refused to get a Windows machine. 
My old DOS computer just keeps on going, like the 
energizer bunny. But Q&A has finally given me a problem. 
My main database is locked and now gives me a message 
“Problem: Cannot Run on Non-Network Drive” 

Terry 

When you run into this problem, perform the following 
steps: 

1. Exit Q&A. 

2. At the DOS prompt, type “CD\DOS” and press Enter. 

3. At the DOS prompt, type “SHARE” and press Enter. 

4. At the DOS prompt, type “CD\QA4” and press Enter. 

5. Type “QA” and press Enter. 

6. From the Q&A Main Menu, proceed through the 
following menu selections: 

File 
Design
 Secure a File 
[Select or type the database name] 
Declare Sharing Mode 
Set to “Automatic” instead of “Allow” 
Press F10 

All will be fixed. If the problem occurs again, try to 
remember what you did right before it happened. My bet 
is that you have a macro that ran amok and changed 
your sharing mode to “Allow.” On a standalone DOS 
machine, this tells Q&A that it’s is on a network. If it’s 
not on a network, it will lock the database. 

Which Server’s Best? 
We have a client running Q&A for Windows on Windows 
95/98 client machines. The data resides on a Windows NT 
server. We would like to upgrade the server to Windows 
2000 Server. The client machines would remain as 
Windows 95/98. Is there any problem running the data on 
a < 2.0GB Windows 2000 Server partition? Thanks. 

Patrick 

None whatsoever! Windows 2000 Server is my server of 
choice! Q&A, unlike the forthcoming Sesame database 
management system, is strictly a client-based program 
(not client/server). It has no idea and doesn’t care what 
the operating system is outside of it’s own 
“neighborhood.” As long as QAWIN is running on the 
client machines and those machines are Windows 3x or 
9x, the server operating system is of no concern. Even in 
a network installation where the Q&A program resides 
on the server, it is called and run from the client. The 
size of the partition the data resides on is important for 
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keeping the data healthy — it needs to be smaller than 
2GB as you have it. If you later change any of the client 
machines to Windows 2000 or XP, you will need the 
NTFIX.EXE patch from www.johntdow.com. 

Make a Database Generation OneMake a Database Generation OneMake a Database Generation OneMake a Database Generation OneMake a Database Generation One 
I have worked with you and Tom and you have both 
repeatedly told me to make sure that my Q&A 5.0 
databases are kept in generation 1 status. I continually 
redesign my databases, but I can never keep it straight 
as to exactly what is required to make sure a database is 
generation 1, or how to make it so. Is there a set of steps 
you could give us for accomplishing this? 

Ana 

So many people ask this question that it’s appropriate to 
cover the same ground again. Also, with Sesame on the 
horizon, now is a good time to start practicing good 
database housekeeping. The steps to make sure that a 
Q&A 5.0 database is at generation 1 are as follows: 

1. Always, always work with a backup of your database. 

2. Step through every menu choice on the File / Design / 
Customize a file menu by selecting each one in turn, 
then pressing F10 until the Customize menu returns. 

3. Step through every menu choice on the File / Design / 
Program a file menu by selecting each, and then 
pressing F10 until the Programming menu returns. 

4. Redesign all reports and print specs under the 
Reports / Design/redesign a report and the File / 
Print / Design/Redesign a spec menu choices. 
Highlight each report and print spec and press F10 
until you get the message “Your report (or Print Spec) 
has Been Saved Do you want to …”. Select “No” and 
continue until you have run through all your reports 
and specs in this manner.* 

5. Run a null mass update to bring all your records to 
the same generation. From the File / Mass Update 
menu, select the database, press F10 at the Retrieve 
Spec, F10 at the Update Spec, and answer “No” to the 
“Do you want to review …” question. 

6. From the Q&A Main menu, select File / Copy / Copy 
Design Only. 

7. Assign a new database name and press F10. 

8. From the Copy menu select Copy selected records. 

9. Press F10 four times. 

The new copy of the database is now Generation 1. 

* For the tedious task of report and print spec redesign, I use a 
simple macro to step through the hundreds of reports I have. 
The only thing I have to do is highlight (select) the report I 
want and then press Alt-X. Here’s the macro: 

<begdef><altx><name>”Redesign<sp>Reports”<vidon>
 
<f10><f10><f10><f10>n<enter><enter><enddef>
 

For those with many, many reports in a single 
database, Listing 2 on the following page shows a 
macro that processes an entire page of reports at one 
shot. It doesn’t matter if the page isn’t full. Listing 3 on 
the next page shows a macro to do pages 1 and 2 at the 
List of Reports screen. You can make one for pages 3, 4, 
and 5, if you have that many pages of reports. These 
macros are run from the List of Reports screen. 

What Sesame Will and Won’t TranslateWhat Sesame Will and Won’t TranslateWhat Sesame Will and Won’t TranslateWhat Sesame Will and Won’t TranslateWhat Sesame Will and Won’t Translate 
I’d like to know exactly what Sesame will convert from my 
current Q&A databases and what it won’t so that I can 
start my conversion planning. 

Jim 

The following is a good rule of thumb. Remember, Sesame 
does not “convert” a Q&A database to something new. It 
translates it and creates a new Sesame application from 
it. Your Q&A database remains unchanged. 

What Sesame will translate from a Q&A database: 

• Its form or screen design. (For Q&A for Windows 
databases, only the Master form will be translated.) 

• All of the database’s records (data). 

• Field formatting (Format Spec). 

• All of the database’s programming. 

• The Lookup Table 

• All your saved Retrieve specifications. 

• All your saved Sort specifications. 

• All your saved Mass Update specifications. 

• All your field restrictions. 

• Basic format and structure of your columnar reports. 

• Most of your Color Palette settings. 

What Sesame will not translate: 

• Macros and Custom Menus (not part of database). 

• Intelligent Assistant/Query Guide items. 

• Saved Navigation, Merge, and Print specs. 

• Cross-Tab reports. 
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• Q&A Write documents and saved label designs. 

• Field templates. 

<begdef><altr><name>”Save a Report”<vidon><f10><f10><f10><f10>N<enter><enter><enddef>
 

Listing 1. Macro that steps through redesign of each Report. Run from the Report List of Files screen with report highlighted. 

<begdef><alt1><name>”Do<sp>Page1"<vidon>
 
<dn><altr>
 
<dn><dn><altr> Bill Halpern is co-owner of Professional Computer
 
<dn><dn><dn><altr> Technology Associates (PCTA) in Newtown,
 
<dn><dn><dn><dn><altr> Pennsylvania and is President and CEO of Lantica
 
<dn><dn><dn><dn><dn><altr> Software, LLC. 215-598-8440. bill@pcta-usa.com,
 
<dn><dn><dn><dn><dn><dn><altr> www.pcta-usa.com.
 
<dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><altr>
 
<dn><rgt><dn><altr>
 
<dn><rgt><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<enddef>
 

Listing 2. Macro that steps through all the reports on the first page of the List of Reports screen. 

<begdef><alt2><name>”Do<sp>Page2"<vidon>
 
<pgdn><dn><altr>
 
<pgdn><dn><dn><altr>
 
<pgdn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><altr>
 
<pgdn><dn><rgt><dn><altr>
 
<pgdn><dn><rgt><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<pgdn><dn><rgt><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><dn><altr>
 
<enddef>
 

Listing 3. Macro that steps through all reports on page 2 of the List of Reports screen. 
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Sesame Tutorial cont’d from page 5 

To save your new database, look for the Control 
Panel called Commands. It should be the top one. Click 
Save Layout Design to activate the Control Panel by 
setting focus to it. Click Save Layout Design again to 
save your new database. The screen will flash briefly. 

To 
confirm 
that your 
design 
was 
saved, 
scroll 
down 
until you 
see the 
Control 
Panel 
called 
Message 
Log. 
Different 

types of messages will appear in this area. In this case, it 
should be empty except for the message that your design 
was saved. 

Scroll back 
up to the 
Commands 
panel and 
click Close 
Design Tab. 
The Design 
Tab will 
close, 
leaving you 
at the Design 
Menu Tree. 

At the most 
basic level, 
you have 
just created a 
new 
database. It 
cannot hold 
data yet, 
because you 
have not 
added any 
fields, but 
Sesame 
Designer 
knows that 
you have a 

new application, with a Contacts database. 

Step 4 – Add Layout Elements to the Form 
A Sesame database stores information in Fields. A 
Sesame form displays information in Layout Elements 
(like a text box). When you place a text box called “First 
Name” on a Form, you are instructing Sesame Designer 
to do the following: 

1. Add a field to the database named “First Name.” 

2. Place a text box on the form that will show the value in 
the “First Name” field. 

Because the text box shows whatever value is in the 
“First Name” field, we say that the text box is bound 
(tied) to the “First Name” field. By placing text boxes 
and other controls on your Form, you are, behind the 
scenes, actually creating your database fields. Let’s take 
a look at this in action. 

Open the Contacts Form that you just finished 
creating. On the Design Menu Tree, click Forms. Click 
Redesign/Customize A Form. Click Contacts to show 
the list of Forms in the Contacts database. In this case, 
there is only one. To open it, click Contacts. 

Sesame 
Designer 
opens a 
Design 
Tab with 
the blank 
Contacts 
form. 

Start 
by adding 
a text box 
to the 
Form. The 
previous 

tutorial, Part 1—Create an application (in the March 2003 
issue), detailed how to do this by clicking on the Form 
and typing a name followed by a colon. So, click on the 
Form and type First Name:. Press Enter. Type Last 
Name:. Press Enter. Repeat these steps to add the 
following text boxes: Address; City; State; Postal Code. 

Save your design by clicking Save Layout Design on 
the Commands Control Panel. You will need to click 
twice. You have just added six text boxes to your Form, 
and created six new fields in your database. (See top of 
next page.) As in the previous tutorial, this is actually 
sufficient to get you a working database, but we want to 
have more than just “working” at this point. 

Step 5 – Changing Properties 
A property is any characteristic of the Form or Layout 
Element. Color, Font, Visibility, and Name are all 
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properties. Earlier in this tutorial, we used the Property 
Editor to change the name of the Form. Now, we’ll use 
the Property Editor to change some other properties. To 
change properties, you select what element(s) you want 
to change, then use the Property Editor to alter them. 

Change the Form color 
Select the Form by clicking on or cursoring to any area 
that does not contain a Layout Element. Click the Color 
tab on the Property Editor. From the Set dropdown, 
select Back/Fill. Click on any of the 32 color swatches to 
see the form background color change. When you have a 
color you like, click Save Layout Design. 

Change 
Layout 
Element 
Colors 
Select the First 
Name text box 
by clicking on 
it. Note: 
Clicking on the 
label will not 
select the 
element. You 
must click on 
the text box 
itself. Type 

some text in it, so you will be able to see changes to the 
text color. 

The Color Tab of the Property Editor should still be 
set to Back/Fill. Click on the color swatches until First 
Name has a background color that you like. From the 
Set dropdown, select Label. Click on the color swatches 
until First Name has a label color that you like. From the 
Set dropdown, select Text.  Click on the color swatches 
until First Name has a text color that you like. Save your 
layout design. You remember how to save by now, right? 

Change Layout Element Text 
Leaving First Name selected, click on the Text tab of the 
Property Editor. The Set dropdown should have Label 
selected. Use the enabled dropdowns to change the font 
face, size and enhancements of First Name’s label. 
Change the Set dropdown to Text and try some changes 
on the sample text. Save your Layout Design. 

Change the Layout Element Look 
Leaving First Name selected, click on the Look tab of the 
Property Editor. The choices on this tab control the 
shape and style of the Layout Element and the position 
of the Layout Element’s label. (See top of next page.) 
From the Box Shape dropdown, select Rounded. From 
the Box Style dropdown, select Shadow. 

The Label Alignment dropdown (see top of next 
page) allows you to place the label text in relation to the 
text box. The diagram illustrates where the label will 
land for the numbered selection. 

Experiment with the Look settings until the First 
Name Layout Element looks the way you want. Save 
your layout design. 
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Copy Layout Element settings 
Once you have First Name looking the way you like, 
let’s make all the text boxes look the same way. Color, 
Text and Look settings can be copied from other 
elements using the Make Like Me tool. 

First, select the elements you want to change. Click 
on Last Name to select it. Hold down the Shift key and 
click on Address. You should now have both elements 
selected. Still holding down the Shift key, click on City, 
State, and Postal Code in turn. Release the Shift key. You 
should now have all the elements selected except First 
Name. Note: You can also select multiple elements by 
clicking on the canvas and dragging across the elements 
to select them. This is called “rubberbanding.” 

Now that you have all the elements that you want to 
change, right-click on First Name. From the right-click 
pop up menu, select MakeLikeMe, then select All. All 
the Layout Elements should now look the same. (See top 
of adjacent column.) Save your layout design. 

Positioning and Sizing Layout Elements 
The main Application Designer manual covers moving 
and sizing elements by using the keyboard and by 
dragging the resize handle (which is the small box 

appearing at the lower-right corner of selected elements) 
with the mouse. This tutorial will use the Property 
Editor to size and position elements. Click on the 
Position tab of the Property Editor. Click on the Form 
canvas to deselect the currently selected elements. Select 
First Name. Some of the elements are not wide enough. 
To increase the width of First Name, click in the Width 
box on the Position tab and type 300. Click the button 
next to the Width box. 

Let’s also move First Name closer to the left edge of 
the Form. Click in the X Position box on the Position tab 
and type 80. Click the button next to the X Position box. 
First Name moves to the left. 

First Name looks good, so let’s do the same thing to 
Last Name. This time, we’ll take a shortcut. Select Last 
Name. Note that the settings you typed in to work with 
First Name are still there on the Position tab. This time, 
simply select Set from the Apply All Settings 
dropdown. Last Name both resizes and moves to the 
left. (See top of next page.) 

You can also work with multiple elements at once. 
Click on the Form canvas to deselect the currently 
selected elements. Use rubberbanding or Shift-Click to 
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select all six text boxes. From the Align Horizontally 
dropdown, select Left. (You may need to scroll down to 
see the bottom portion of the Position tab.) All the 
elements should now be left-aligned with First Name. 

All the elements are lined up now, but Address and 
City are still too short to hold the expected information. 
Deselect the currently selected elements. Use 
rubberbanding or Shift-Click to select Last Name, 
Address and City. From the Size To Match dropdown, 
select Widest. All three selected elements should now be 
the same width. 

Now, in the example shown in the screen shots, the 
changes made to the label font and alignment have 
made the form look too crowded. The elements need to 
have more vertical space between them. The Property 
Editor includes a way to easily remedy this. Deselect all 
selected elements. Use rubberbanding or Shift-Click to 
select all six text boxes. From the Vertical Space 
dropdown, select More. Keep clicking More until there 
is enough space between the elements. (See top of next 
column.) Save your layout design. 

Convert Contacts.dsr into Contacts.db 
We’re finished building our Contacts application. Now, 
we need to convert the application design (contacts.dsr) 
into an actual Sesame Application (contacts.db). 

Close the Design Tab by clicking Close Design Tab 
in the Commands Control Panel. The Design Tab will 
close, leaving you at the Design Menu Tree. 

On the 
Design 
Menu Tree, 
click on 
Application 
to expand 
the 
Application 
menu. Click 
on Save As 

New Application. 

In the Filename box, type c:\sesame\data\contacts.db. 
Click Accept. 

Sesame 
Designer creates 
contacts.db and 
contacts.dat. 
Together, these files 
hold your entire 
Sesame 
application. 

Close Sesame 
Designer by 
clicking Exit on the 
File menu. There 
will be a brief 
delay while 

Sesame Designer exits. You should now be at the Sesame 
window from which you originally launched Sesame 
Designer. 
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On the File menu in the Sesame window, click Open 
Application. Then click contacts.db. (Top of right 
column.) 

Erika Yoxall is the technical coordinator for Lantica Software, LLC. 
Sesame will load your new Contacts Application. 

You are ready for data entry! 
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 Program Retrieves cont’d from page 3 

Complex string manipulation 
To find records where the third-from-last character in 
the “Item” field is a backslash: 

{@Mid(Item, @Len(Item)-2, 1) = “\”}
 

To find field values of a certain length 
Short, or especially, long values, which might cause 
problems with mailing labels, merge documents or 
exports: 

{@Len(Comments) > 255}
 

Although the @Len function is commonly used to 
determine the length of a text string, it can also be used 
though to find the length of a number field. An integer 
from 0 to 9 will have a length of 1, an integer from 10 to 
99 will have a length of 2, and so forth. A definite case 
of a solution in search of a problem! 

Mixed Search logic 
Where Retrieve Spec programming really comes into its 
own, is where you have mixed “And” and “Or” 
conditions across fields. Such retrieves are impossible to 
do without programming. 

The best example is the “Chase Creditors” situation. 
You want to print out a list of, or send letters to, all those 
people who are overdue on their payments. Who do you 
the send the letters to? 

You want those who are overdue a long time who 
owe a moderate amount, and you also want those who 
owe you a lot even if they are less severely overdue. In 
Retrieve Spec terms you want: 

Overdue moderate time AND amount due is large 
OR 
Overdue long time AND amount due is moderate 

You need criteria in two fields, and you need a 
mixed “And” and “Or” across them. Assuming there’s a 
Date Paid which is blank if not paid, and fields for 
Invoice Date and Amount, the programmed Retrieve 
would look like this : 

Date Paid : “”
 

Any Field: { (Invoice Date <@Date-30 AND
 
Amount>5000 ) OR (Invoice Date <@Date-60 AND
 
Amount>2000 ) }
 

To repeat—you create and then save these Retrieve 
Spec programs, either with Reports or as standalone 
Saved Retrieve Specs. The example above will produce 
different records each day because the dates are being 
compared to the current date, no matter what date that 
is. 

Furthermore, all these programmed Retrieves—if 
they don’t start with an equals sign, and if they use 
Field Names—will not only translate into Sesame from 
your Q&A database, but will work in Sesame to give you 
the same consistent results. 

New case-sensitive search support 
Q&A does not give you a way to perform a case-sensitive 
search on the first character in a field—but Sesame does. 
In Sesame, if you type a Retrieve Spec parameter like 
this: 

City: ~c..
 

You’ll get a match on “cleveland” and “canton,” but not 
“Cleveland” or “Carrollton.” Note that this replaces 
Q&A’s seldom-used “Soundex” (sounds like) feature. 
Sesame was not going to support Soundex anyway. 

Alec Mulvey is a director of Lantica Software, LLC and also owns 

Keyword Software & Consultancy in Ascot, near London, England. Alec 

has been building Q&A applications and training clients for 12 years. 

Keyword Software is the UK distributor for the International English 

edition of Q&A. alec@keywordsoftware.com, http:// 

www.keywordsoftware.com. 
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